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Creating and Routing Contracts in Contracts+ 

Because the Contract Templates and Contracts editing pages look similar, the header boxes at the 
top of the page are color coded and includes status information (Active, Draft, etc.) and Template 

Actions. When you are working on Contract Templates, the header box at the top is purple. For 

Contracts, the header box is light blue.  

You may also use the list on the left side to navigate between pages of the contract templates and 
contracts. Make sure to regularly click Save Progress as you create your contract templates and 

contracts so that your entered data is saved. Clicking Next will also save your data.  

Contracts+ keeps a running record of all the changes made on the software. As you are creating 
contract templates and contracts, click History on the top right-hand corner under the header box 

to view details of all the changes made.  

There should only be one contract template per project unless there are multiple bid packages. All 

contracts and supporting documents needed for a project can be created from a single contract 

template. Please delete any duplicate contract templates.  
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Contract Templates 

Creating a Contract Template 

1. Go to Contracts on the navigation menu. 

2. Under Libraries, select Contract Template Library. 

3. Enter Capital in the Search by Name, Contract Type, etc. field within the Contract 

Templates tab. 

a. NOTE: Please use the templates already created in the system for your university 

instead of the Create Template feature. Make sure to create a copy of this contract 

template instead of editing this contract template directly to prevent any overriding 

of the original contract template.  

4. Click Search. 

5. Select View Active next to the name of the template appropriate to your organization from 

the list of Active templates. 

a. Capital Chicago Contracts 

b. Capital Springfield Contracts 

c. Capital System Contracts 

d. Capital Urbana Contracts 

6. To create a copy of the Contract Template, go to Template Actions on the purple header 

box and select Copy. 

a. NOTE: The system will create a copy of the template. The purple header box will 

indicate that it is currently in Draft status and fields are now editable.  

Naming Convention - Contract Templates 

• Always start with a single ‘Z’ to sort Capital templates to the bottom of the overall list. 

• Include the project number. 
• Include the project name. 

• If there are multiple templates, include something to differentiate the templates. 

Examples: 

• Z 606-C20093 Replace Windows Student Center East Tower 

• Z S22013 UIS Innovation Center 

• Z U18041 BP2 – ISR Townsend & Wardall Hall Renovation 

Updating a Contract Template 

1. Enter a name in the Template Name field for the new contract template according to the 

naming convention. 
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2. Select the appropriate Contract Type.  

a. To remove the existing entry, click the X next to the field. 

b. Click the Search (magnifying glass) icon to locate the appropriate Contract Type.  

c. Use the Search bar or expand and select one from the Capital category.  

d. Click Save Changes.  

3. Select the appropriate Work Group. 

a. To remove the existing entry, click the X next to the field. 

b. Click the Search (magnifying glass) icon to locate the appropriate Work Group.  

c. Use the Search bar or expand and select one from the list.  

d. Click Save Changes. 

4. Do not enter information for Value or Second Party because that would apply to every 

contract and will require manual deletion or editing later. 

5. Ensure that all the fields for General Contract Info are correct. These fields are 

automatically imported from the template.  

6. Enter information in the fields under Unit Info that you want to populate on every contract. 

7. Go to Template Actions on the purple header box and select Finalize and Activate. 

8. Click Yes. 

a. NOTE: The system will activate this template into an active template. The purple 

header box will indicate that it is now in Active status. 

9. To edit an Active template, click Create Draft on the purple header box. 
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Contracts 

Naming Convention - Contracts 

The naming convention for contracts is the same as contract templates, except there is no single 

‘Z’.  

• Include the project number. 

• Include the project name. 

• If there are multiple templates, include something to differentiate the templates. 

Examples: 

• 606-C20093 Replace Windows Student Center East Tower 
• S22013 UIS Innovation Center 

• U18041 BP2 – ISR Townsend & Wardall Hall Renovation 

Creating a New Contract 

1. Go to Contracts on the navigation menu. 

2. Under Contracts, select Create New Contract…. 

3. Enter a name in the Contract Name field for the new contract according to the naming 

convention. 

4. Select the appropriate Contract Type.  

a. Click the Search (magnifying glass) icon to locate the appropriate Contract Type.  

b. Use the Search bar or expand and select one from the Capital category.  

c. Click Save Changes.  

5. Select the appropriate Contract Template. 

a. Click the Search (magnifying glass) icon to locate the appropriate Contract 

Template.  

b. Use the Search bar (enter project number) or select one from the list.  

c. Click Save Changes.  

6. Verify the Work Group is correct for the Contract Type selected.  

a. NOTE: If the Work Group is incorrect, change it to the appropriate Work Group. This 

will ensure that the contract number has the correct prefix (CN or CAP).  

7. Select the appropriate Main Document Template. 

a. Click the Search (magnifying glass) icon to locate the appropriate Main Document 

Template.  
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b. Use the Search bar (enter project number) or click Select next to desired template 

on the list.  

8. Click Create Contract. 

a. NOTE: The system will create a new contract from the template. The light blue 
header box will indicate that it is currently in Draft status and fields are now 

editable.  

b. NOTE: The transfer of data from a contract template to a contract is a one-time 
occurrence. Any changes made on the data of this contract will not affect the data on 

the contract template, and vice versa.   

Editing a Contract 

All contract items with an asterisk must be completed so that they are put through the correct 
workflow. Contracts are required to have second parties. Supporting documents do not require 

second parties and will not go through the approval workflow because they do not need a 
Comptroller signature. Therefore, necessary data from a reporting and process standpoint must be 

completed.  

1. Open the contract you want to edit. 

a. NOTE: Many of the fields will have been transferred over from the template. 

2. Complete the necessary groups for the type of document that you are generating. 

a. NOTE: Please refer to the Main Document Data Mapping job aid under 

Contracts+ on the Capital Training page for a chart with more details.    

Header 

3. Enter the Value of the contract. 

a. NOTE: A negative number cannot be entered in this field. Therefore, if the value is a 

negative number, enter “0” instead.  

4. Click Add Party next to Contract Parties.  

5. Enter the name of the Second Party in the search field.  

6. Click Search (magnifying glass icon).  

7. Select appropriate Second Party from the list.  

8. Click Select Contract Party.  

9. Click Next to bypass choosing a contact.  

10. Select the appropriate address in the drop-down menu for Choose An Address.  

11. Click Done.  
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12. Review the Contact Address Information.  

13. Click Done.  

14. Select the appropriate Capital Contract Type from the drop-down list. 

Amount 

15. Enter the Amount of the contract.  

a. NOTE: The value in the Amount field should be the same as the Value field in the 

header. However, if the amount is a negative number, you may enter it in this field.  

Capital Info 

16. Ensure that the data for the fields under Capital Info is imported correctly from the 

contract template.  

17. Under Capital Project Information, fill out all the fields in this section.  

Editing the Contract Main Document  

Using the information entered for the contract, Contracts+ will generate a Main Document. There is 
a textbox on the top of the document with a guiding checklist and reminders of what items need to 

be completed before moving on to Internal Review. When you are editing the Main Document, 

make sure the document is checked out to you using the JAGGAER Contract Authoring Word 

Application. Please remove the text box before submitting the contract for review.  

Attachments 

1. Go to Attachments page on the navigation list on the left.  

2. Click the Main Document file in the Attachment column to download onto your computer. 

3. Open the file in Microsoft Word to edit.  

a. NOTE: You may have to click Enable Editing to edit the document.  

4. If the Second Party information has not all been migrated into the Main Document, please 

do the following: 

a. Exit out of the Main Document. 

b. Go to the Project Delivery Method page on the navigation list on the left. 

c. Select No for Using PRZM.  

d. Select back to Yes for Using PRZM.  

i. NOTE: This forces the system to generate a new version of the main 

document with the Second Party information.  
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e. Return to the Attachments page. 

i. NOTE: The number of versions for the Main Document will have increased by 

two to reflect the edits you just made. 

f. Click the Main Document file in the Attachment column to download onto your 

computer. 

g. Open the file in Microsoft Word to edit.  

5. Under the Home tab on Microsoft Word, select Show Taskpane for JAGGAER.  

a. NOTE: This will open the JAGGAER Contract Authoring Word Application pane 

next to the document.  

6. Click Continue on the application to confirm yourself as the user. 

a. NOTE: You can see that the contract is checked out to you with a timestamp on the 

top along with the Draft status.   

7. Under the Review tab, use the Comments feature Previous and Next to easily jump to 
items that need to be entered directly into the Main Document Word file. These items are 

marked with comments that provide additional guidance.  

8. If there are custom fields on the main document that need to be entered or corrected, go 

back to the Header in Contracts+ to make the changes.  

9. Once all the items are completed, check to see if there are any custom fields that were 

missed.  

a. Under the Home tab, click Find in Editing. 

b. On the Navigation pane, enter “[[“ (double brackets) to search for any missed 

custom fields.   

10. If you need to insert or edit text into the Main Document, make sure to paste text only to 

maintain the original formatting of the Main Document. 

11. Click Check In on the bottom of the JAGGAER Contract Authoring pane. 

12. Enter a description of the changes you made in the field.  

13. [Optional] Select the checkbox to Keep this contract checked out to me.   

a. NOTE: You may want to enable this if you need to go talk to someone about what to 

enter in the custom fields and return to this document later.  

14. Click OK. 

a. NOTE: A notification will appear on the bottom that indicate that your edits were 

successfully checked in. To edit the contract again, click Check Out. 

15. Return to the Attachments page on Contracts+. 

16. Refresh the page. 
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a. NOTE: The number of versions for the Main Document will have increased by one to 

reflect the edits you just made.  

17. Go to the Actions drop-down and select Version History.  

a. NOTE: The Main Document Version History screen will appear listing each version of 
the Main Document including the attachment file and details (date when the version 

was uploaded, who made the changes, and included comments).  

Comparing Versions 

1. To compare versions of the Main Document, click Select in the Compare column for each 

of the document versions you want to compare. 

2. Once the document versions are added to the Compare Section, click Compare. 

a. NOTE: The documents will appear side by side on a new page. Edits are highlighted 

in yellow for easy comparison.  
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Internal Review Round 

The Internal Review Round is an automated workflow that facilitates the review of a contract by 

designated reviewers. It is not an approval process to obtain the comptroller’s signature. Users at 
each step review the header data and the main document and then provide comments. Only one 

user needs to act on the Review Round at each step. Review Rounds automatically bypass steps 
where at least one user is not assigned to the necessary step. Risk Management Review has no 

configuration so it will always be bypassed. 

The Internal Review Round must be initiated by the Contract Administrator and proceeds only 

forward. A reviewer cannot return the process to the previous step. If a Reviewer identifies a need 
to stop the Internal Review Round, they must notify the Contract Administrator. Only the Contract 

Administrator can end an Internal Review Round at any time in any status for any reason. A 

contract can go through multiple Internal Review Rounds.  

All contracts, which includes advertisements and front end documents, require Internal Review 

Round except contracts with a Contract Type of ‘Capital – Change Orders.’  

Initiating an Internal Review Round 

Review Rounds 

1. Go to the Review Rounds page on the navigation list on the left.  

2. Click Start Automated Internal Round. 

a. NOTE: If you want specific people to review the contract before starting the 

automated Internal Review Round, click Create Manual Internal Round. Search 
and select the reviewer(s), then click Save Changes. Once you return to the Review 

Rounds page, click Begin Round, enter a message to reviewers, and click Begin 

Internal Review.  

3. Enter a message to send to all reviewers in the Message to Reviewers field. 

a. NOTE: This message will be sent to reviewers as an email notification. Therefore, 

please enter adequate details for reviewers to review appropriately.  

4. Click Begin Automated Internal Review. 

a. NOTE: Reviewers will be notified via an email notification or an on-screen 

notification in Contracts+. 

i. The email notification contains the contract number, name of the Contract 

Administrator, and the Internal Review message created by the Contract 

Administrator. 

ii. The on-screen notification in Contracts+ contains the contract number. 

5. Click View Automated Internal Review Steps to expand and view the reviewers required 

for each step.  

6. View the Current Round (Internal) section to see details for each step. 
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a. Click Edit to add additional information in the message that was sent to all the 

reviewers.  

b. Click End Round Now to end the Internal Review Round at any time.  

Reviewing During the Internal Review Round 

1. Log into Contracts+. 

2. Access the contract via one of the following: 

a. Notifications in Contracts+ 

i. Click the Notifications (bell) icon in the header. There will be a blue oval 

over the icon with the number of notifications.  

ii. Select the desired notification and you will be taken to the Internal Review 

group for the contract.  

b. Email Notifications 

i. Click View Contract on the email to go to the Contract Summary page in 

Contracts+. 

3. Review the contract by using the navigation menu on the left to view specific contract 

information. 

a. NOTE: Use the Communication Center if changes need to be made to the contract. 

Changes must be made to the document before completing the review.   

4. Go to the Contract Actions on the light blue header box. 

5. Select Done with My Review.  

6. Enter a comment for the Contract Manager in the textbox. 

a. NOTE: This comment can also be viewed by other reviewers.  

7. Click Done with My Review. 

8. Expand the Current Round (Internal) section to see details for the review you just 

completed and that the contract was sent to the next reviewer. 

Using the Communication Center 

If there are changes that need to be made to the contract, please use the Communication Center 

to work with the Contract Administrator to make those changes before completing the review. 

1. Access the Communication Center via one of the following: 

a. Communication Center page 

i. Go to the Communication Center page on the navigation list on the left.  
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ii. Click Add Internal Message. 

b. Contract Actions 

i. Go to the Contract Actions on the light blue header box. 

ii. Select Add Internal Message. 

2. For Subject, enter the contract number, Project name and any other clarifier about the 

document content so that reviewers know which contract you are referring to.  

a. Example: CN_00074877 on Assigned Subcontractor for U19035 

3. For Body, enter the message you want to communicate. 

4. Expand the Recipients section by clicking on Recipients. 

5. Enter the names of those you want to send this message to.  

a. NOTE: Please include the contract administrator and all the reviewers who were 

involved in the prior steps of the Internal Review Round.  

6. Click Create. 

a. NOTE: An email notification will be sent out to the recipients regarding this new 

message. They will also find a notification in Contracts+.  

Initiating Another Internal Review Round 

Once the first Internal Review Round is complete, the Contract Administrator will receive an email 

notification communicating that the Internal Review for the contract is over and the contract is in 

the Draft status.  

1. Click View Contract to open the contract in Contracts+.  

2. View the details of each review step in the Round #1 (Internal) section.  

3. Click Start Automated Internal Round to start another Internal Review Round.  

a. NOTE: If you want specific people to review the contract before starting the 

automated Internal Review Round, click Create Manual Internal Round. Search 
and select the reviewer(s), then click Save Changes. Once you return to the Review 

Rounds page, click Begin Round, enter a message to reviewers, and click Begin 

Internal Review.  

Ending the Internal Review Round 

For automated internal rounds, the internal review round will automatically end when all the 

reviewers have completed their review. If the contract admin needs to end the internal review 

round for any reason, follow these steps below.  

1. Click End Round Now.  
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a. NOTE: A notification screen will appear notifying that if you end the round now, 

reviewer(s) will be skipped.  

2. Click End Round.  
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Obtaining Second Party Signatures 

Once the Main Document is complete, a clean version needs to be sent out (without notes and 

comments) to the Second Party for signatures via email. Once the signed versions are received, it 
needs to be uploaded with supporting documents to Attachments and assigned as the Main 

Document that should be printed with the full contract (replacing the old main document versions).   

Sending Main Document to Second Party Vendors for Signature 

1. Open the Main Document in Microsoft Word. 

2. Go to the Review tab. 

3. Under Tracking, select No Markup in the Display for Review drop-down list.  

4. Save the file. 

5. Email the file to the Second Party vendor for signatures.  

Uploading Signed Main Document 

1. Open the appropriate contract. 

2. Go to the Attachments page on the navigation list on the left.  

3. Under Contract Actions, click Check Out.  

4. Click Add Attachments. 

5. Select Add My Own for Attachment Type. 

6. Click Select files… 

7. Select the signed main document file. 

8. Click Open.  

a. NOTE: In case the file size is too big, reduce the file size in Adobe by following these 

steps: 

i. Open the file in Adobe. 

ii. Click the File tab. 

iii. Under Save as Other, select Reduced Size PDF. 

iv. In the Reduce File Size dialog box that appears, click OK. 

v. In the Save As window, choose where you want to save the new version of 

the PDF. 

1. NOTE: It is recommended to change the name of the file to better 

differentiate between the original and reduced versions. 
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vi. Click Save. 

1. NOTE: Adobe will reduce the size of the file and save a new version. 
This may take a few minutes depending on the size of the file you 

started with. If the contract is still too large, it is recommended to run 
it through the compression process a few more times to further reduce 

the size.  

9. Once the signed Main Document is uploaded, click Save Changes.  

a. NOTE: The new attachment will be listed in the Attachments page, but the crown 

remains next to the old Main Document attachment.  

10. Click Action next to the old Main Document attachment. 

11. Select Unassign as Main Document.  

12. Click Yes.  

13. Click Action next to the old Main Document attachment again. 

14. Select Edit Properties.  

15. Select No next to Print with Full Contract. 

16. Click Save Changes.  

17. Click Action next to the attachment you just uploaded. 

18. Select Set as Main Document. 

a. NOTE: Now the crown should be next to the new attachment noting it as the Main 

Document.  
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Approval Workflow 

Contracts+ will automatically generate an approval workflow based on the contract type and items. 

It is critical to make sure all required sections are complete and accurate before 

submitting for approval.  

Completing the Approval Workflow 

1. Go to the Submit for Approval page on the navigation list on the left. 

2. Make sure all required sections are completed.  

a. NOTE: Go to the incomplete sections by clicking from the given list or the navigation 

list on the left to complete the required items.  

3. To see the approval workflow, click View Approval Steps to expand.  

a. NOTE: Click View approver under each step to see who the approvers are. 

4. Click Submit for Approval.  

5. Enter a message to the approvers in the field, as needed.  

6. Click Submit for Approval. 


